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Attention newsrooms: 
It’s time to get serious 
about 2024 elections 

coverage. I hear the collective 
groan. The reaction is likely 
shaded by the strident national 
contests and their seemingly 
never-ending campaign cycles.

Community newspapers 
must toss aside the cynicism 
of the national political scene 
and focus on what they do 
best: Help readers make in-
formed decisions at the polls, 
particularly for candidates 
seeking seats on city coun-
cils, school boards, county 

boards and other local elective 
offices. 

You are in excellent po-
sition to collect and present 
information in a clear, mean-
ingful manner — all in the 
interest of advancing democ-
racy.

Election coverage is a 
demanding responsibility, 
especially as many newsrooms 
deal with diminished resourc-
es. Every aspect is scrutinized 
— from candidate profiles and 
debate coverage to editorial 
endorsements and treatment 
of letters to the editor to how 
results are reported. 

The enormity of the task 
requires that staffs thor-
oughly plan all the elements 
of coverage. The better the 

organization, the easier it will 
be to handle the unexpected 
circumstances.

Candidate interviews are 
at the heart of substantive 
coverage. Each race has its 
specific issues. Many candi-
dates will be prepped for the 
usual queries, often aided by 
written notes. Be attentive to 
their answers for appropriate 
follow-up.

But also think of un-
orthodox questions to force 
candidates to think on the spot 
and delve into territory not 
typically covered at the usual 
candidate forums. 

Avoid questions that cannot 
be answered by a simple “yes” 
or “no” without elaboration. 

Unconventional Interview Questions: 
How to make candidates think on the spot 

Continued on Page 11

About 200 people attend-
ed a March 7 public hearing 
on a recommendation to 
repurpose the U.S. Postal 
Service Processing and Dis-
tribution Center in Tulsa.

The proposal includes 
shipping mail received at the 
Tulsa facility to Oklahoma 
City for processing.

Many at the meeting held 
signs that said “Save Our 
Service.”

USPS officials said the 
Tulsa Processing and Distri-
bution Center facility would 
remain open for other Postal 
Service uses. 

The move is part of the 
Postal Service’s ‘Delivering 
for America” plan, a $40 

USPS discusses 
Tulsa conversion

Continued on Page 5

CATCH THE WAVE
O K L A H O M A  P R E S S  A S S O C I A T I O N 
Annual Convention

Sheraton Oklahoma City 
Downtown Hotel

1 North Broadway Ave.  
Oklahoma City, OK 73102

JUNE 7-8, 
2024
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From the President
By Sheila Gay

Publisher of the Woodward News • OPA President 2023-2024

Got News?
Share news about your 
newspaper with other OPA 
members!

If you have a new hire, sales 
promotion, contest, or have 
received an award or honor 
tell us about it so we can put 
it in The Oklahoma Publisher.

Send your news or story ideas to

aanderson@okpress.com  

or call 405-499-0020

OPA CALENDAR 
OF EVENTS
For more information  

on upcoming events, visit 

okpress.com/events

Thur., April 11, 2024
NAVIGATING THE AI 
LANDSCAPE IN  
JOURNALISM

Dive into the dynamic world of 
Artificial Intelligence (AI) with 
Dwayne Desaulniers, as he 
demystifies the core concepts 
of AI, explains its mechanisms 
and guides you on initiating your 
AI journey.

Thur., April 18, 2024
BOOST YOUR BRAND 
TRUST AND SEO WITH 
AUTHOR PROFILES

Let’s dive into the SEO advan-
tages and how these pages 
establish your business as an 
industry leader.

Thur., May 2, 2024
OKLAHOMA JOURNALISM 
HALL OF FAME CLASS OF 
2024 INDUCTION

The induction ceremony begins 
at 11:30 a.m. Thursday, May 
2, in the Grand Ballroom of the 
Nigh University Center at the 
University of Central Oklahoma.

Fri. & Sat., June 7-8, 2024
2024 OPA  
ANNUAL CONVENTION

Mark your calendar and plan to 
attend OPA’s convention.

I’ve been told that I have a 
“squirrel” mind.  

I think of one thing and then 
move to the next and hopefully 
circle back to a solution that 
works in the meantime. 

Which brought to mind this 
fun quote I had seen back in 
my running days: 

“I got up this morning and 
ran around the block 5 times. 
Then I got tired, so I picked up 
the block and put it back into 
the toy box.” 

I would imagine this is how 
most of us feel on most days 
that end in the word day. 

I believe I am an out of the 
box thinker (aside from the 
squirrel thing) and can bring 
a solution to most the issues 
that arise. As I am also sure 
most of us have that talent in 
our industry as well. But there 
are those days that we feel 
like we’ve done everything 
we could possibly think of and 
there was still no solution. The 
block just seems heavy, un-
moving and at times grounded 
with cement. 

Ok, this is not supposed to 
be a negative column so bear 
with me. 

When we find ourselves 
looking for ideas, answers and 
solutions, hopefully we turn 
to resources we have available 
to us. 

I recently went to an event 
at our local library with no 
intent to actually get a library 
card. As I was walking around, 
I noticed all of the new reading 
nooks along with computers 
for all age levels. 

I thought what a cool chill 
place to just sit and read, along 
with all the new shiny books 
on display just waiting to be 
read! 

Before I knew it, I was 

getting a library card at age 55 
and a “date with a book” I had 
no idea the genre of but was 
extremely excited to read! 

The 347 pages seemed 
a little daunting but that’s 
another story for another time 
(squirrel). Oh, and reading is 
on my 2024 bingo goals card 
(squirrel). 

Oh, I had a library card 
back when I was younger and 
an avid reader, but I had not 
applied for one since all of the 
change and technology has 
increased what libraries offer 
today for FREE. 

What really had me was 
all of the apps and resources 
available to me outside of 
the normal reading material. 
From actual books, to audible, 
to videos/movies on several 
platforms available to down-
load to tablets or iPhones, it’s 
incredible and I’m having the 
best time!  

EARN YOUR PRESS PASS
Which brings me to this 

point and the one word that 
ties everything together is 
RESOURCES. 

Here’s the point: OPA has 
made it possible for journalists 
to participate in the free “Earn 
Your Press Pass” through 
online training.

The program is designed to 
teach journalism fundamentals 
to new reporters with little to 
no experience, so they learn to 
create valuable news coverage. 

Recruiting a new experi-
enced reporter can be difficult, 
but if you find someone that 
wants to write and cover their 
community, then this course 
will teach them the journalism 
basics to succeed. Long-time 
reporters may even pick up a 
few tips! 

A variety of practical course 
topics are offered. Each train-
ing video is around 10 minutes 
in length; and the full course 
is approximately eight hours. 
Some PDF materials are also 
available with certain courses 
so you can print or save them 
for easy reference.  

Courses include: Inter-
viewing, First Amendment, 
Effective Editing, Associated 
Press Style, Headline Style, 
Finding Stories, Newspaper 
Jargon, Simple Photography, 
Journalism Ethics, Writing a 
Story, Covering a Meeting, and 
more. 

What a valuable resource 
and tool for OPA members to 
have at our fingertips. 

If you’re ready to review 
and begin training, email Alex-
is Martin at OPA, amartin@
okpress.com.

OPA also offers training 
webinars, advertising ideas and 
contests! 

So, bringing it back to the 
block scenario (remember 
I’m a squirrel), the block can 
become tiresome as we run 
around it looking for solutions 
and we may give up and put it 
back in the toy box. 

But what if we took a better 
look at resources available and 
leave the block out of the box? 

All of the solutions to fixing 
the block could be right in 
front of us. 

If none of this works and as 
an absolute last resort, throw 
the block in a river, it’s taking 
up too much time! 

Have a great month! 
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The Hooker Advance 
weekly newspaper marked 
a milestone of 120 years of 
continuous publication of local 
news, photos and advertising 
last month.

Sadly, it is the end of its 
publication. Publisher Shei-
la Blankenship has had the 
weekly newspaper for sale for 
more than 15 years but without 
a buyer, the longtime weekly 

paper ceased publication on 
March 7.

The 120th anniversary was 
still celebrated with a big 120th 
birthday bash at the Hooker 
American Legion Hall on 
February 21.

 “It was wonderful to be 
able to observe this occasion 
with so many of our faithful 
readers, students, friends and 

neighbors,” said Advance Pub-
lisher Sheila Blankenship.

The event was celebrated 
with barbecue, birthday cake 
and ice cream. The more than 
200 who attended the event 
had a chance to purchase 
special centennial Advance 
editions from 2004, register 
for door prizes, donate to the 
Hooker Historical Society, look 
over the Advance office and 
staff photos from the past 12 
decades, and share memories 
of their hometown paper.

 “I am very proud of how 
The Advance has always 
focused on our local and area 
families and what is important 
to them; and of how hard we 
have worked to keep our read-
ers informed on the who, what, 
where, when, why and how,” 
Blankenship said.

“It has always been an 
amazing blessing to me to be 
able to support our communi-
ty.”

Blankenship, who has been 
publisher since 1995, started 
working at the Advance two 
days after graduating from the 
Oklahoma State University 
School of Journalism in May 
1980.

 

Final chapter for Hooker Advance 
culminates in 120 year celebration

The Hooker Advance staff, from left, Billye Fischer, Sheila Blankenship and Karla 
Huxman, celebrate 120 years of the local newspaper on Feb. 21.

You’ve Got Questions!
•	 Can I photograph minors without consent?

•	 Can police deny access to records by issuing a press release?

•	 Should I alter my archives when a person demands it?

•	 Can I report inaccurate testimony given in open court?

•	 What are the laws about liquor advertising?

These are questions answered by the attorneys for the OPA Legal Services  
Plan members in recent months. OPA members always need timely legal  
advice on issues related to publishing.

You should join OPA’s LEGAL SERVICES PLAN!
See www.OkPress.com/LSP or contact Mark Thomas  

at (405) 499-0033 or toll-free in Oklahoma 1-888-815-2672 today!
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© 2021 OGE Energy Corp.
We honor our commitment to strengthen our communities.

At OG&E, we do more than 
energize a power grid. 

LEFT: Mariah Dightman to the bucket against Harrah. 
Photo by MIKE MONAHAN, Guthrie News Leader, January 24, 2024

ABOVE: Tyler Holsapple prepares to ride his skateboard at the Enid Skate Park.
Photo by BILLY HEFTON, Enid News & Eagle, January 31, 2024

JANUARY 2024 WEEKLY WINNER:

MIKE MONAHAN
Guthrie News Leader

JANUARY 2024 DAILY, SEMI- AND TRI-WEEKLY WINNER:

BILLY HEFTON
Enid News & Eagle

The January 2024 contest  was judged by a member  of the Oklahoma  Journalism Hall of Fame.

View all winning photos and contest rules at OkPress.com/OGE-Photo-Contest
Enter and Win a $100 Check from OGE ENERGY CORP.

For more information about the photo contest, visit okpress.com/oge-photo-contest
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A Health Threat Causing
Missed School Days

In Oklahoma, it’s still legal to smoke in 
cars where kids are present. When children 
live with secondhand smoke at home, they 
suffer more asthma attacks, ear infections 
and respiratory illnesses — and rack up 
absences as a result. The research is clear. 
Why isn’t the air?

Learn more about the impact of secondhand smoke at: 

USPS Tulsa conversion
billion investment strategy “to 
upgrade and improve process-
ing, transportation, delivery 
networks and employee ex-
periences across the country,” 
according to the USPS.

Tulsa’s is among at least 
17 Processing & Distribution 
Centers that have been identi-
fied for conversion across the 
country as the USPS continues 
efforts on its Delivering for 
America plan. 

The Tulsa World reported 

that Mary Steelman, executive 
plant director at the Processing 
and Distribution Center in Fort 
Worth, said during the public 
hearing that delivery service in 
Tulsa would be unaffected by 
the change, prompting a wave 
of guffaws from the audience.

Steelman said no final de-
cision has been made regard-
ing the Tulsa facility. A final 
decision will be made in one 
to two months, according the 
USPS.

Continued From Page 1

Joyce Carney has been 
doing what she loves most — 
working for newspapers — for 
more than 50 years.

For the last 42 of those 50 
years, she has been publisher 
of The Country Connection 
News in Eakly.

Just last year she was 
inducted into the Oklahoma 
Press Association’s Half Cen-
tury Club.

“That’s a big deal!” said 
Carney. “I got to sit at the 
President’s table and watch 
a video of myself on a big 
screen.”

But many of her friends 
in the newspaper business 
weren’t there to see her 
receive the award. They had 
retired.

Carney was ready to slow 
down but wanted to pass her 
newspaper on to someone who 
would love her readers and 
advertisers like she did.

That’s where Cory Cart 
comes in. Carney learned the 
young man from Binger that 
she had watched grow up 
had moved back home from 
Louisiana.

The two met and it was 
soon decided Cart would 
become publisher of The 
Country Connection News. 

His first issue as publisher was 
March 6.

“God has blessed me all 
these years with wonderful 
coworkers, advertisers and 
readers,” said Carney. “Now 
He has blessed me with the 
perfect person to hand over 
‘my baby’ to.”

Cart, who said he made his 
living in the media industry as 
a public relations practitioner, 
never expected to become a 
weekly publisher, but he’s 
ready for the challenge.

He’s already implemented 
some new material including 
a podcast for The Country 
Connection News readers 
featuring stories from Caddo 
County.

A new weekly devotional 
by Sally Oliphant-Mickle is 
being added as well as a col-
umn by the newspaper’s new 
travel editor Elaine Warner.

“I look forward to helping 
Caddo County thrive,” said 
Cart. 

Joyce Carney Cory Cart

Joyce Carney passes the torch
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Tulsa World promotes Dallas West

The Oklahoma Press Asso-
ciation Board of Directors met 
February 8 at the State Capitol 
in Oklahoma City.

Officers attending were 
President Sheila Gay, Wood-
ward News; Vice President 
Shauna Belyeu, The Eufaula 
Indian Journal; and Treasurer 
David Stringer, The Lawton 
Constitution.

Directors attending were 
Past President Zonelle Rain-
bolt, Wesner Publications; 
Suzie Campbell, Countywide 
& Sun; Erin Dyer Thompson, 
El Reno Tribune; Ed Choate, 
Muskogee Phoenix; Shaun 
Witt, Oklahoma Watch; and 
Connor Choate, Marietta 
Monitor. Brett Wesner, Wesner 
Publications, was absent.

Staff attending were OPA 
Executive Vice President Mark 
Thomas and Member Services 
Director Lisa Sutliff. 

After calling the meeting to 
order, Gay asked the board to 
review the minutes of the De-
cember 7, 2023, and January 4, 
2024, meetings. The minutes 
were approved as presented.

The board reviewed 
the OPA and LSP financial 
statements and investment 
reports as of December 31, 
2023. Stringer said revenue 

and expenses both increased. 
Thomas said LSP is defending 
one libel suit, which it is trying 
to dismiss on the basis of the 
Oklahoma Citizens Participa-
tion Act (anti-SLAPP law).

The board acknowledged 
receipt of the OPA and LSP 
financial statements and invest-
ment reports as presented.

Three membership appli-
cations were approved at the 
meeting, pending successful 
completion of publication 
in the February issue of The 
Oklahoma Publisher and a 20-
day protest period. Member-
ship applications were:

• The Pryor Information 
Publication (General News 
Media Membership). The 
community news website at 
pryorinfopub.com began in 
June 2019 and is owned by 
Tim Lawton, who also serves 
as editor.

• Ellis County Star (General 
News Media Membership). 
The publication is owned by 
Last Refuge Media, Inc., with 
Walter Wagnon as publisher. 
Its first issue was Sept. 22, 
2022.

• STATE Magazine (Affili-
ate News Media Membership). 
Mack Burke, associate director 
of media relations at Oklaho-

ma State University, submitted 
the application for this publica-
tion, which is distributed three 
times per year to 36,000 paid 
alumni association subscribers.

Committee reports includ-
ed the Government Relations 
Committee. Thomas reviewed 
legislative bills affecting open 
meetings, open records and 
newspaper industry business 
during the February 8 Legisla-
tive Summit. 

Rainbolt will chair a meet-
ing of the Nominating Com-
mittee on March 15 at 10:30 
a.m.

Belyeu will chair an online 
video meeting of the Board 
Strategic Planning Committee 
on March 28 at 10 a.m.

OPS BOARD MEETING
Minutes of the December 7, 

2023, meeting were approved 
as presented.

Board members reviewed 
the OPS financial statements as 
of December 31, 2023. String-
er said advertising revenue is 
higher than budgeted and staff 
are looking toward political 
season. The board acknowl-
edged receipt of the financial 
statements as presented.

OPA Board meets at State Capitol

Dallas West is the new mar-
keting team lead for the Tulsa 
World Marketing Team.

The team is led by Misti 

Rinehart, vice president of ad-
vertising for the Tulsa World.

“Dallas West isn’t just a 
skilled marketing consultant; 
she’s a natural leader,” Rine-
hart said. 

“This promotion is more 
than just a new title. It’s a rec-
ognition of her ability to unite 
and empower others.”

West joined the Tulsa World 
in November 2021, special-
izing in education and health 
care industries.

She has a bachelor’s degree 
from Rogers State University 

and a master’s degree from 
National University.

“The Tulsa World’s market-
ing landscape is undergoing an 
exciting and dynamic evolu-
tion, and I’m thrilled to be part 
of this pivotal journey,” West 
said.

“I’m committed to lead-
ing our talented team toward 
achieving even greater results. 
The Tulsa World Marketing 
Team possesses a collective 
expertise that fuels my eager-
ness to witness the remarkable 
accomplishments we’ll achieve 
together.”

Dallas West

Angela Nichols recently 
joined the staff of the Clinton 
Daily News.

As the newest reporter on 
the staff, Nichols will be writ-
ing business stories, criminal 
reports and municipal govern-
ment updates.

Originally from Altus, 
Nichols is a graduate of Na-
vajo High School and South-
wester State University where 
she received a bachelor’s 
degree in strategic communi-
cations with a minor in public 
relations.

She has lived in Clinton 
for almost a year after moving 
from Weatherford. 

Nichols said as the lead 
news reporter at the Clinton 
Daily News, she hopes to 
become acquainted with more 
people in Clinton.

For 30 years, Faith Wylie, 
John M. Wylie II and Carolyn 
Estes researched and created 
the Newspaper in Education 
(NIE) feature “For the Kid in 
You.”

Now they are retiring.
“We have enjoyed provid-

ing this feature for 30 years 
and thank our subscriber 
newspapers and their tens of 
thousands of kids,” said John 
Wylie.

The Wylies published the 
Oologah Lake Leader from 
1984 to 2017. Estes served 
as advertising director for the 
weekly newspaper.

Even after the Wylies sold 
the newspaper, they continued 
producing the “Kid,” which 
was syndicated nationally to 
more than 30 weeklies and 
dailies.

For more information about 
the Kid, contact Faith Wylie at 
flwylie@att.net.

Nichols joins 
Clinton Daily

After 30 years NIE 
feature Kid ends
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Please donate to the  
OKLAHOMA 
NEWSPAPER  

FOUNDATION
Donations to the  

Oklahoma 
Newspaper 
Foundation  
will support  

its efforts  
to improve the  

state’s newspaper 
industry and  

quality of 
journalism.

Checks may be sent to  
OKLAHOMA 
NEWSPAPER 

FOUNDATION
3601 N. Lincoln Blvd. 
Oklahoma City, OK 

73105-5499
or donate online at 

https://okpress.com/ 
donations/

Remembering our 
friends & colleagues 

who died  
the previous year.

Mary Elizabeth Claiborne 
February 3, 2023

Dayle McGaha 
February 27, 2023

Keith Skrzypczak 
February 11, 2023

Harry Leroy Hix, Jr. 
March 24, 2023

Carl Ray Lewis II 
March 6, 2023

John G. Lord 
March 13, 2023

DEATHS

JOHN WILLIAM HOLT, an 
Oklahoma journalist, died 
February 12, 2024. He was 88.

Holt was born December 
10, 1935. He joined the Navy 
Reserve while in high school.

After spending two years 
at sea, he returned to finish 

his college education at the 
University of Nebraska, gradu-
ating in 1960 with a degree in 
journalism.

He soon joined the Ama-
rillo Daily News as a reporter. 
From there, he joined the 
Oklahoma City Times cover-

ing the state capitol. He later 
served as spokesman for the 
highway department and for 
several energy related busi-
nesses.

Holt is survived by his wife 
Lois; and sons Brian and Kirk.

JANICE ‘JAN’ KAY ROLL-
INS VASSAR, who worked 
at several publications, died 
February 5, 2024. She was 83.

Vassar was born June 19, 
1940, in the Indonesian village 
of Talang-Akar. She spent 
the early years of her life in 
Pendopo, Sumatra, Indonesia, 
where her father worked in the 
oil industry.

The family later settled in 
Tulsa. 

After receiving her bache-
lor’s degree from the Univer-
sity of Tulsa, she married Paul 
Miner Vassar in 1962.

Vassar worked in journal-
ism for many years, including 
KTUL television in Tulsa, for 
various publications includ-
ing the Stroud American, the 
Lincoln County News and 

freelance work. From 1985 
to 2010 she was editor of the 
tribal newspaper and head 
librarian of the Sac and Fox 
Nation of Oklahoma. 

She was active in the com-
munity and state and enjoyed 
traveling. 

Simmons is survived by 
her husband Paul; and sons 
David of Dallas and Andrew 
of Tulsa.

KENNETH ROBERT MILAM, 
an Oklahoma journalist, died 
January 31, 2024. He was 70.

Milam, who was a member 
of the Choctaw Nation, was 
born February 19, 1953. He 
attended Northeastern State 
University, earning his bache-
lor’s degree in journalism. 

He started his writing ca-
reer at the Muskogee Phoenix 
in the late 70s, and then wrote 
for the Tulsa World throughout 
most of the 80s. After that, 
he wrote off and on for the 
Poteau Daily News until he 
retired.

He made a substantial 
contribution to the American 

Association of Petroleum 
Geologists Bulletin during his 
last decade of professional 
writing.

Milam is survived by his 
wife, Tina Malinowski; sons 
Adam, Eli and Ian; daughter 
Kendal; and two grandchil-
dren.

OJUIETA FAYE (SMITH) 
SIMMONS, a former em-
ployee of the Anadarko Daily 
News, died Feb. 3, 2024. She 
was 93.

Simmons was born March 
4, 1930, in Mountain View. 
She graduated from Anadar-
ko High School in 1947 and 

then attended the Oklahoma 
Business College for Women, 
graduating with a business 
degree.

She worked at the Anadar-
ko Daily News as a typeset-
ter and helped with payroll. 
Simmons also transcribed 
correspondence from then 
Daily News publisher Joe 

McBride Sr. She retired from 
the newspaper in 1992.

She was preceded in death 
by her husband William H. 
“Buddy” Simmons Jr. in 1974.

Simmons is survived by 
her daughter Sharon Abbott of 
Verden; three grandchildren; 
and four great-grandchildren.

KAREN GOODWIN, former 
editor/publisher of the Rush 
Springs Gazette, died February 
15, 2024. She was 77.

Goodwin was born June 
8, 1946, and grew up on the 
family farm in the Alfalfa/
Eakly area.

She married Billy “Conn” 
Goodwin on December 21, 
1963.

In 1983, Karen and Conn 

purchased the Rush Springs 
Gazette. Although Karen said 
she didn’t know everything 
about putting a newspaper 
together from start to finish, 
she jumped in and learned as 
much as she could. In the early 
years of owning the newspa-
per, she pulled all-nighters to 
get the paper to press on time. 

After 28 years as editor 
and publisher, Karen sold the 

newspaper to Mary Hill on 
September 1, 2017.

During her brief years of 
retirement, Karen served the 
Cumberland Presbyterian 
Church wherever she was 
needed, and enjoyed meditat-
ing in her garden.

Karen is survived by her 
husband, Conn; daughter 
Lori Lemons; son Shonn; two 
grandsons and one grand-
daughter.
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Oklahoma Attorney Gen-
eral Genter Drummond, the 
publisher of the McCurtain 
County Gazette, an Oklahoma 
attorney who created a free-
dom of information website 
and a longtime journalist have 
been named as the recipients 
of the 2023-24 Freedom of In-
formation Oklahoma’s awards.

FOI Oklahoma also is 
awarding a Special Commen-
dation to the Oklahoma Su-
preme Court and Chief Justice 
M. John Kane IV.

All of those being honored 
exemplify the goal of open 
and transparent government 
in Oklahoma. They will be 
officially recognized this 
fall at the First Amendment 
Congress, planned in October 
at the University of Central 
Oklahoma.

The award recipients are:
Marion Opala  
First Amendment Award:  
JOSH D. LEE 

According to the nomina-
tion, “Josh Lee is the attorney 
that all attorneys in Oklahoma 
go to for how to pursue Open 
Records litigation.”

Lee was the attorney and 
plaintiff in the seminal case 

in Oklahoma that declares all 
police dash cam recordings 
subject to disclosure under the 
Oklahoma Open Records Act 
in the matter of Ward & Lee 
v. Claremore. Lee created the 
website FOIBible.com. The 
website is a tremendous re-
source to the public, attorneys 
and members of the media.

“Mr. Josh Lee’s work de-
serves recognition as he is an 
inspiration to many attorneys 
in fighting the good fight for 
the right reasons, and making 
an agency change their prac-
tices,” said the nomination.
Ben Blackstock Award:  
BRUCE WILLINGHAM

The McCurtain County 
Gazette published a series of 
stories in early 2023 detailing 
how the McCurtain County 
sheriff and county commis-
sioners were conducting ille-
gal meetings, which included 
threatening to hang Black 
people and kill journalists. The 
stories and recording garnered 
national attention to the plight 
of open meetings and records 
in this southeastern Oklahoma 
county.

“Willingham and his son, 
Chris, took the ultimate risk 

in exposing the importance of 
sunshine when public offi-
cials are involved in potential 
wrongdoing,” the nomination 
said. “He showed the spirit of 
Ben Blackstock in performing 
this public service for his com-
munity,” said the nomination.
Sunshine Award:  
ATTORNEY GENERAL 
GENTER DRUMMOND

The Republican attorney 
general created a public access 
position in his office to help 
ensure state and local offi-
cials comply with the Open 
Meeting and Open Records 
Act. After taking office 
in 2023, Drummond also 
worked to clear a backlog of 
open records requests at the 
Oklahoma Attorney General’s 
Office. Drummond’s creation 
of a public access position in 
his office will have a long-last-
ing impact on public access to 
information in Oklahoma. His 
dedication to open government 
sets an example for others to 
follow. 
Special Commendation:  
OKLAHOMA SUPREME COURT 
& CHIEF JUSTICE  
M. JOHN KANE IV

After a request from jour-

nalist Tres Savage of NonDoc, 
the Oklahoma Supreme Court 
made video recordings of past 
oral arguments available for 
the public on the Oklahoma 
Supreme Court Network web-
site. The decision will give 
Oklahomans a better under-
standing about how their court 
system works and access to ar-
guments in cases that have the 
potential to affect their legal 
rights and state government.
Bickham-Hale Service Award:  
WILLIAM ‘BILL’ CRUM

After years of service 
to FOI Oklahoma as a 
dedicated board member 
and financial supporter, the 
longtime journalist is retiring. 
He is stepping down from 
the FOI OK board to “invite 
the next generation to help 
lead the organization.”

“Bill made great use of 
Oklahoma’s open records and 
meeting laws throughout his 
career,” the nomination said. 
“His contributions to keep-
ing the people of Oklahoma 
informed through his report-
ing and his contributions to 
the FOI Oklahoma board are 
worthy of recognition.” 

FOI Oklahoma announces 2023-24 award winners

CHICKASAW NATION  
MEDIA RELATIONS

Loné Beasley
580-559-0921
lone.beasley@chickasaw.net
chickasaw.net

ETYPE SERVICES
Thad Swiderski
512-687-9055
thad@etypeservices.com
etypeservices.com

FEED THE CHILDREN
Carrie Snodgrass
(405) 213-9757
carrie.snodgrass@ 
	 feedthechildren.org
feedthechildren.org

GRAND RIVER DAM AUTHORITY
Justin Alberty
918-256-5545
justin.alberty@grda.com
grda.com

MENTAL HEALTH ASSOCIATION 
OKLAHOMA

Adi McCasland
405-250-6331
amccasland@mhaok.org
mhaok.org

METRO CREATIVE GRAPHICS
Jennifer Steiner
800-223-1600
jsteiner@metro-email.com
metrocreativeconnection.com

OGE ENERGY CORP.
Christi Woodworth
405-553-3698
woodwoco@oge.com
oge.com

OKLAHOMA ASSOCIATION OF 
ELECTRIC COOPERATIVES, INC.

Chris Meyers
405-478-1455
cmeyers@oaec.coop
oaec.coop

OKLAHOMA BAR ASSOCIATION
Janet Johnson
405-416-7000
janetj@okbar.org
okbar.org

OKLAHOMA DEPARTMENT OF 
REHABILITATION SERVICES

Jody Harlan, Comm. Director
405-203-1318
jharlan@okdrs.gov
oklahoma.gov/okdrs.html

OKLAHOMA MEDIA CENTER
Rob Collins, Project Manager
405-205-9421
rob.collins@localmedia.org
oklahomamediacenter.com

OKLAHOMA STATE SCHOOL 
BOARD ASSOCIATION

Christy Watson, Comm. Director
405-528-3571
christyw@ossba.org
ossba.org

OKLAHOMA NATURAL GAS
Chad Previch
405-501-9509
Chad.Previch@onegas.com
oklahomanaturalgas.com

PHILLIPS THEOLOGICAL  
SEMINARY 

Kurt Gwartney
918-270-6470
kurt.gwartney@ptstulsa.edu
ptstulsa.edu
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a Publisher

Covering the northeast 
Oklahoma communities of 
Inola and Catoosa, the Inola 
Independent consistently 
produces a quality newspaper 
filled with a wide range of lo-
cal news and sports stories that 
are complimented by attention 
grabbing photographs.

The Independent also does 
a great job promoting itself. It 
is common to see ads trying to 
get new print and online sub-
scribers and lure advertisers.

One that grabbed my atten-
tion read, “The Independent 
Has Gone Viral!!! 7 Days A 
Week / 24 Hours A Day. Ad-
vertisers Call 918-543-3134. 
Also Call To Subscribe For 
Local Online News” 

Another promoted the 
advantages of publishing 
your legal notices in the 
Independent. “Prompt-Accu-
rate-Friendly. Our services 
include: Accurate & Timely 
Publication of your legal case, 
Tearsheets & invoices mailed 
Promptly, Free filing of paid in 
full Proof of Publication in the 
Rogers County Courthouse, 
Free notarization on the first 
copy, and additional copies for 
your own use.”

Too many newspapers are 
so focused on telling business-
es the importance of news-
paper advertising they forget 

that also applies to their own 
product. 

It would be good for most 
newspapers to follow the 
Independent’s example of 
using newspaper advertising to 
promote their business.

The Carnegie Herald 
did its part to let everyone 
know about the 80th Annual 
World Championship Domino 
Tournament held in the small 
southwest Oklahoma town.

Unlike Carnegie, very few 
communities with a population 
of less than 1,500 can boast 
of being the home to a world 
championship.

In promoting the event, 
The Herald did an excellent 
job letting readers know how 
the tournament began back in 
1945. “Doc Jolly started the 
tournament in the local VFW 
Hall. He timed that contest to 
coincide with local farmers 
winter quiet time.”

It gained national notoriety 
after being mentioned in a 
1965 Sports Illustrated article. 
In the article former Carnegie 
Herald editor Roy McCurley 
disputed a tournament in San 
Francisco’s claim to be the 
‘world championship’ noting 
Carnegie’s tournament had 
actually predated California’s 
contest by more than two 
decades. 

This should remind re-
porters of the important role 
newspapers have in providing 
the recorded history of the 
communities they serve.

The next week The Herald 
continued to do its part to 
update the history of the 
World Championship Domino 
Tournament when the 2024 
winners were put in print.

The nameplate on The 
County Times proudly 
includes the slogan, “The 
Positive Side of Comanche 
County.”

From the newspaper’s 

office in Cache, The County 
Times does just that!

It is common to see more 
than 20 quality pictures and 
stories about good things that 
are happening in Cache and 
other communities throughout 
the county.

During a recent visit to The 
County Times, Publisher Ve-
nius Dobson said that focusing 
on positive news had made 
her job much more enjoyable 
because readers continually 
express their pleasure with the 
newspaper for making good 
news its priority. 

Even though I didn’t know 
anyone that appeared in the 
paper, it was enjoyable to look 
through several recent editions 
of The Times and see “The 
Positive Side of Comanche 
County!”

The Logan County Courier 
exemplifies community jour-
nalism at its best!

Each week readers are 
exposed to stories and pictures 
covering a wide range of 
events that have happened in 
the area.

In recent issues readers of 
the Courier learned about a 
car accident that claimed the 
lives of two local people, the 
United Way in Logan County 
breaking contribution records, 
how to navigate through the 
road construction in the region 
and saw photos of people 
honored at the chamber of 
commerce banquet. 

There are also stories pro-
moting upcoming events like 
the Crescent Ground Hog Day 
and homecomings in Logan 
County.

We salute them for the sto-
ry it regularly publishes titled, 
“Why you need to advertise 
your product / business!!”

The story explains to busi-
nesses that advertising helps 
educate consumers about how 
your products or services help 

them and what their brand 
stands for.

It also reminds consumers 
that the objective of advertis-
ing is to inform, to persuade, 
and to remind.

Judging from the number 
of ads from area businesses 
in each edition, the Courier 
is proving newspapers are a 
great place to promote any 
business – including your own 
product.

The Lawton Constitution 
joins the Mangum Star and 
Atoka County Times in con-
ducting readership surveys in 
the past few months.

The Constitution is the 
latest Oklahoma newspaper 
wanting to determine how 
area residents feel about news, 
what they’re interested in, 
what they’re not and how 
they feel in general about the 
media.

It was designed to be com-
pleted on The Constitution’s 
Facebook page and take less 
than 10 minutes to complete. 

Let’s never forget that our 
readers are our customers. The 
more we gear our product to 
them, the more valuable your 
newspaper becomes to them.

TOP FIVE HEADLINES:
5.	 PERFECTION 

– Choctaw Times

4. 	 The Hunt For A Star   
– The Dewey County 
Record

3.	 What’s coming to town 
next?  
– The Piedmont-Surrey 
Gazette 

2.	 Antarctica in Ada  
 – The Ada News

1.	 Witness: Seeing remains 
of man changed her life  
– McCurtain Gazette

Looking  
Them Over
by Rod Serfoss

rserfoss@okpress.com

Cultivating advertising, circulation customers

Rod Serfoss, OPA Business Consul-
tant, looks over OPA member publica-
tions for a monthly column, “Looking 
Them Over.” To contact Serfoss, 
email rserfoss@okpress.com.

Inola Independent - 02/21/2024 Page : b05.pdf.0

March 11, 2024 2:46 pm (GMT +0:00) 

BOOK FOR SALE
Speaks Christ’s Love

225 Pages of Sermonettes 
and Testimonies

This devotional book feeds 
the soul. It makes a great 
gift, fits everyone and its 

value lasts forever. 
WITHIN THE VEIL

By Betty Carlton
Price: $12 plus $5 packag-
ing and shipping. 
Betty Carlton, 17159 Ea-
gle Drive; Claremore, OK 
74017; (479)238-3895
heartsongs@atlasok.com
bettylcarlton@gmail.com

FOR SALE

BULLETIN
WATCH FOR 

THE
CHECK ✓ 

on the address line of 
your subscription to 
Th e Independent
If  You See the Check ✓ 

Your Subscription Is 
Expiring

Lifted...
And seek the peace of the city whither I have caused you 

to be carried away ..., and pray unto the LORD for it:  
Jeremiah 29:7 

Lifted...
And seek the peace of the city whither I have caused you 

to be carried away ..., and pray unto the LORD for it:  
 Jeremiah 29:7 
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16 words for $5 and 30¢/word thereafter
(a word is anything with a space on either side) • Deadline is Monday at Noon

BULLETIN
WATCH FOR 

THE
CHECK ✓ 

on the address line of 
your subscription to 
Th e Independent
If  You See the Check ✓ 

Your Subscription Is 
Expiring

ENTERTAINMENT

Jim Loyd and the River 
Road Band plays music the 
second Saturday of each 
month at Inola Senior Cit-
izens Building. Free snacks 
are offered. The music 
is from 6 p.m. to 9 p.m.  
Donation at the door, the 
money goes to help Senior 
Citizens and the band.
Free Snacks.

TFZ

Sophisticated Seconds Hos-
pice Store, 41st and Yale, 
4016 S. Yale Ave. Tulsa, 
539-664-5177 Open until 
6 p.m. need: Volunteers and 
Donations. Call Rita: 918-
747-2273

1/6/18 TFZ  NC

HELP NEEDED

Your Community Weekly Newspaper

RESIDENTIAL CUSTOMER

The
Independent

A publication of Black Fox Media covering Inola and Catoosa

The Independent
113 w. Commercial ~ Inola, Okla.

PO Box 999, Inola, OK 74036
918-543-3134

inolanewspaper@tds.net

The Independent 
Has Gone Viral!!

www.theindependentnewspapers.net
7 Days A Week/24 Hours A Day

Advertisers Call 
918-543-3134
Also Call To Subscribe For Local Online News

CARD OF 
THANKS

Free one time classified 
word ad 15 words or less 
918 543 3134. Call Martha

NOTICE
One Year Subscription to 

your hometown newspaper. 
Just $25 per year.

Mail a check to the Inola 
Independent for Black Fox 
Media newspapers dba The 
Independent in Inola and 
Catoosa  P.O. Box 999, Ino-
la, Ok. 74036

SHOP 
LOCALLY!

THIS COPY ONLY FOR THE WEEK OF  
Nov 3-9, 2019 – (OCAN110319). 

Please choose the copy below that best fits your ONE column width. Thank you.
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1.5” X 8.25” 1.66” X 8.1”

TULSA GUN SHOW
WORLD’S LARGEST GUN SHOW – 
November 9 & 10 - Tulsa, OK Fair-
grounds. Saturday 8-6, Sunday 8-4. 
WANENMACHER’S TULSA ARMS 
SHOW. Free appraisals. Bring your 
guns! www.TulsaArmsShow.com

WALK-IN SHOWERS
VETERANS Walk-In Showers. 
$6800. 800-975-0056

WANT TO BUY
HANK HAS CASH WILL DASH! For 
old guitars, amps, mandolins, ukule-
les, Gibson, Fender, Martin, Gretsch, 
etc. Top dollar cash paid. 40 years in 
Tulsa. 1-800-525-7273 www.string-
swest.com

ADVERTISE STATEWIDE
Put your message where it mat-
ters most – IN OKLAHOmA 
NEWSpApERS. We can place 
your ad in 158 newspapers.   
For more information or to place 
an ad, contact Landon Cobb at  
(405) 499-0022 or toll-free in OK at 
1-888-815-2672. 

OKLAHOMA  
CLASSIFIED

AD NETWORK
FOR MORE INFO CALL  

1-888-815-2672

TULSA GUN SHOW
WORLD’S LARGEST GUN SHOW – 
November 9 & 10 - Tulsa, OK Fair-
grounds. Saturday 8-6, Sunday 8-4. 
WANENMACHER’S TULSA ARMS 
SHOW. Free appraisals. Bring your guns! 
www.TulsaArmsShow.com

WALK-IN SHOWERS
VETERANS Walk-In Showers. $6800. 
800-975-0056

WANT TO BUY
HANK HAS CASH WILL DASH! For 
old guitars, amps, mandolins, ukuleles, 
Gibson, Fender, Martin, Gretsch, etc. 
Top dollar cash paid. 40 years in Tulsa. 
1-800-525-7273 www.stringswest.com

ADVERTISE STATEWIDE
Put your message where it matters most 
– IN OKLAHOmA NEWSpApERS. We 
can place your ad in 158 newspapers.   
For more information or to place 
an ad, contact Landon Cobb at  
(405) 499-0022 or toll-free in OK at 
1-888-815-2672. 

OKLAHOMA  
CLASSIFIED

AD NETWORK
FOR MORE INFO CALL  

1-888-815-2672

needing
METAL ROOFS  
SIDING OR WINDOWS
for our Advertising Program.

We are opening a branch office & will 
be using these homes for advertising 
purposes.
First 10 homes selected receive $300 
Walmart gift card along w/ $100 gas card.

SAVE HUNDREDS of DOLLARS 
NO mONEy DOWN  

pAymENTS $89/mo*
ALL CREDIT ACCEpTED
Senior/Military Discounts. *wac

Wanted 
 10 homes

IN yOUR COUNTy

CALL NOW!
866-668-8681
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Free one time ad for pet, 
puppy or kitten giveaway  
918 543 3134 Call Martha

PETS

Your Local 
Weekly 

Newspaper 
The Best Place 

to find
 

 • City News
 • Sports
 • School News  
 • Community 
         News
Everything you need to 
know about our town!

543-3134
Subscribe Today!
 $25 a for 1 Year

Subscription

The 
Independent

ZONE: NE
for week of NOVEMBER 3, 2019
2x2 ads may run anywhere in your newspaper. Don’t forget to remind your classifi ed department to download the 
line ads for this week at www.okpress.com/ocan - CHOOSE THE AD SIZE CLOSEST TO YOUR COLUMN WIDTH 

• GUARANTEED 
• FULL AND PT DRIVERS
• NEEDED TO PULL 

HOPPER TRAILERS
Apply in person or online at: Apply in person or online at:

1601 e Blanchard ave. - hutchinson Ks
sunvalleytrucks.com

1601 E Blanchard Ave. - Hutchinson KS
sunvalleytrucks.com

Top drivers earned over 70k. Must 
be at least 25 years old with 3 years 
experience. Benefits include home 
every weekend, dedicated lanes, 
insurance, retirement, vacation pay, 
monthly and yearly bonuses. 

Top drivers earned over 70k. Must be at least 
25 years old with 3 years experience. Benefits 
include home every weekend, dedicated lanes, 
insurance, retirement, vacation pay, monthly 
and yearly bonuses. 

$2,000
sIGn on BonUs!

$2,000
SIGN ON BONUS!

GUARANTEED 
to aLL neW hIRes!

GUARANTEED 
TO ALL NEW HIRES!

Top drivers earned over 70k. Must 

$50,000 & $60,000
GUARANTEED Top drivers earned over 70k. Must be at least 

$50,000 & $60,000
• GUARANTEED • GUARANTEED •
• FULL AND PT DRIVERSFULL AND PT DRIVERS•
• NEEDED TO PULL 
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apache auction market
Apache, OK

Nov. 9th, 2019 at NOON
Selling 800+ head bred cows and pairs including 
complete dispersal for Ronald and Pam Duffer. 

Trace Ranch 100 head of 24 month old home raised 
Angus heifers bred to Saler bulls.

View our website 
www.apacheauction.com 

for more information.

3.08” x 4” 3.75” x 4”

special Cow sale

Apache Auction Market
Apache, OK

Nov. 9th, 2019 at NOON
Selling 800+ head bred cows and pairs including complete 

dispersal for Ronald and Pam Duffer. Trace Ranch 100 head of 
24 month old home raised Angus heifers bred to Saler bulls.

View our website 
www.apacheauction.com 

for more information.

special Cow sale

Half Price 
Walk-In Bathtub 

918-308-1133 

Half Price 
Walk-In Bathtub 

918-308-1133 
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OK Statewide Press Association
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7 Car Wash/Redevelopment Sites

real estate auctions

OK  DEAN WILLIAMS RE LIC 081045. BUYER’S PREMIUM MAY APPLY.

800.801.8003 • williamsauction.com/CarWash

 10150 East 11th Street, Tulsa

All Properties Auction:
12pm Fri Nov 15 at Marriott Southern Hills, 1902 E 71st St,  

Tulsa or bid online at auctionnetwork.com

Currently Operating! Locations include both self-serve and 
automatic as well as vacuuming stations.

BIXBY
• 15056 S Memorial Dr

BROKEN ARROW
• 500 W Florence St
• 6201 S Garnett Rd

GLENPOOL
• 80 East 141st Street

OWASSO
• 9202 North Mingo 
Valley Expressway

TULSA
• 10150 E 11th St
• 9221 S Sheridan Rd

See Website 
for Details

OK Statewide Press Association
3.08 x 4
11/4

7 Car Wash/Redevelopment Sites

real estate auctions

OK  DEAN WILLIAMS RE LIC 081045. BUYER’S PREMIUM MAY APPLY.

800.801.8003 • williamsauction.com/CarWash

Prefer Not to Wait for 
the Auction? Submit a 

Pre-Auction Offer!

 9202 N Mingo Valley Expressway, Owasso

All Properties Auction:
12pm Fri Nov 15 at Marriott Southern Hills, 1902 E 71st St,  

Tulsa or bid online at auctionnetwork.com

Currently Operating! Includes both self-serve, automatic & vacuuming stations.

BIXBY
• 15056 S Memorial Dr

BROKEN ARROW
• 500 W Florence St
• 6201 S Garnett Rd

GLENPOOL
• 80 East 141st Street

OWASSO
• 9202 N Mingo Valley 
Expressway

TULSA
• 10150 E 11th St
• 9221 S Sheridan Rd

See Website for Details

VILLAGE APART-
MENTS, 5 “E” STREET 
NE , INOLA. 1 AND 2 
BEDROOM APART-
MENTS, Newly remod-
eled, laundry facilities on 
site. Call Pat 918 688-6840.

12/2019TFZ

APARTMENTS 
FOR RENT

If you want to drink, that’s 
your business. If you want 
to stop that’s ours. Alco-
holics Anonymous meets 
at Inola Christian Church, 
Saturday 8:00 p.m.TFZ

SERVICES 
OFFERED

Neighborhood Services

Charles Riddle
Owner & Operator

918-695-7382

P.O. Box 316
Inola, OK 74036

Bonded & Insured

Service & Remodel

DDIR LE
&T AIRAEH

Call 
543-3134

To reserve this space

We buy Junk Cars & 
All Types Of SCRAP METAL!!

Copper, Brass & Aluminum
Call For Pricing

918-479-6027 or 918-636-5677 (Cell)

Your Community Weekly Newspaper

The 
Independent

PO Box 999, Inola, OK 74036
918-543-3134            inolanewspaper@tds.net

Help Wanted. Sales, Re-
porting, Misc.  Call 918-
527-1933 

10-16 TFZ

So you want to write? Be a 
writer?  We need sports re-
porters. Want to cover your 
hometown athletics - give 
John a call   918-543-3134

Wanted self starting, mo-
tivated individual. Socially 
talented. Good on one to 
one sales. Call 918-543-
3134.  

10-1 TFZ

HELP WANTED

For Sale Travel Trailer, 
Cherokee; 30 ft Above 
Ground Pool;  Twin Hospi-
tal Bed: Street Legal  Scoot-
er. Nita Deerinwater, 918 
543-2215. 

10/23-11/13 x

FOR SALE

FOR RENT

Trailer for rent and a 3 bed-
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7 Car Wash/Redevelopment Sites

real estate auctions

OK  DEAN WILLIAMS RE LIC 081045. BUYER’S PREMIUM MAY APPLY.

800.801.8003 • williamsauction.com/CarWash

 10150 East 11th Street, Tulsa

All Properties Auction:
12pm Fri Nov 15 at Marriott Southern Hills, 1902 E 71st St,  

Tulsa or bid online at auctionnetwork.com

Currently Operating! Locations include both self-serve and 
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BIXBY
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BROKEN ARROW
• 500 W Florence St
• 6201 S Garnett Rd

GLENPOOL
• 80 East 141st Street

OWASSO
• 9202 North Mingo 
Valley Expressway

TULSA
• 10150 E 11th St
• 9221 S Sheridan Rd

See Website 
for Details
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36915 S. 4215 Rd. 6 Miles 
S. of Inola.  Saturday,  11-
9,  7 a.m. - 3 p.m., 2 com-
pound bows, arrows, misc 
bricks, hammocks, some 
ammo, crock pots, Lots of 
misc.   

11/6x

Trash or Treasure. Sell your 
treasures or your unwanted 
in the Independent for only 
$5 for 15 words or less.

ADVERTISE YOUR 
YARD SALE IN THE IN-
OLA AND CATOOSA 
INDEPENDENT NEWS-
PAPER. ONLY $5 FOR 15 
WORDS OR LESS

GARAGE SALES

Free children’s make and 
take Christmas gift work-
shop. Inola First Baptist 
Church Saturday, Nov. 16  
from 9 a.m. to noon. Ages 
6th grade and under wel-
come. For details contact 
the church office at: 918-
543-2756   

11/6-11/13

WORKSHOP

VETERAN’S DAY
MONDAY, NOVEMBER 11

Honoring All Who Have Served

16 words for $5 and 30¢/word thereafter
(a word is anything with a space on either side) • Deadline is Monday at 5 p.m.

SHOP THE 
CLASSIFIEDS

If you want to drink, that’s 
your business. If you want 
to stop that’s ours. Alco-
holics Anonymous meets 
at Inola Christian Church, 
Saturday 8:00 p.m.                      

TFZ

SERVICES 
OFFERED

THIS COPY ONLY FOR THE WEEK OF  
February 18 - 24 – (ocan021824) 

Please choose the copy below that best fits your ONE column width. Thank you.

1.5” X 5.8” 1.66” X 5.6”

OKLAHOMA 
CLASSIFIED

AD NETWORK
FOR MORE INFO CALL  

1-888-815-2672

OKLAHOMA 
CLASSIFIED

AD NETWORK
FOR MORE INFO CALL  

1-888-815-2672
WANT TO BUY

OLD GUITAR$ WANTED!  LARRY 
BRING$ CA$H for vintage USA  
guitars, tube amps, banjos, mandolins, 
etc. Fender, Gibson, Martin, Gretsch, 
others. Call or text 918-288-2222.  
www.stringswest.com

VETERINARY CARE
When veterinary care is unavail-
able or unaffordable, ask for Happy 
Jack ® animal healthcare for cats, 
dogs, & horses. At Tractor Supply ®  
(www.happyjackinc.com)

OIL & GAS MINERAL SALE
OIL & GAS MINERAL AUCTION 2/29 @ 
2 PM (ONLINE ONLY)  Garfield, Major, 
Blaine, & Kingfisher Co., OK | Producing 
& Nonproducing Minerals | INVESTMENT 
OPPORTUNITY | WigginsAuctioneers.
com | 580.233.3066

ADVERTISE STATEWIDE
Put your message where it matters most 
– IN OKLAHOMA NEWSPAPERS. We 
can place your ad in 144 newspapers.  
For more information or to place an 
ad, contact Landon Cobb at  
(405) 499-0022 or toll-free in OK at 
1-888-815-2672.

WANT TO BUY
OLD GUITAR$ WANTED!  LARRY 
BRING$ CA$H for vintage USA  
guitars, tube amps, banjos, mandolins, 
etc. Fender, Gibson, Martin, Gretsch, 
others. Call or text 918-288-2222.  
www.stringswest.com

VETERINARY CARE
When veterinary care is unavail-
able or unaffordable, ask for Happy 
Jack ® animal healthcare for cats, 
dogs, & horses. At Tractor Supply ®  
(www.happyjackinc.com)

OIL & GAS MINERAL SALE
OIL & GAS MINERAL AUCTION 2/29 
@ 2 PM (ONLINE ONLY)  Garfield, 
Major, Blaine, & Kingfisher Co., OK | 
Producing & Nonproducing Minerals 
| INVESTMENT OPPORTUNITY 
| WigginsAuctioneers.com | 
580.233.3066

ADVERTISE STATEWIDE
Put your message where it mat-
ters most – IN OKLAHOMA 
NEWSPAPERS. We can place 
your ad in 144 newspapers.  
For more information or to place 
an ad, contact Landon Cobb at  
(405) 499-0022 or toll-free in OK at 
1-888-815-2672.

Free one time ad for pet, 
puppy or kitten giveaway  
918-543-3134 Call Martha

PETS
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VILLAGE APARTMENTS, 
5 “E” STREET NE, IN-
OLA. 1 and 2 Bedroom  
Available.   Laundry Facilities 
Onsite. Call Tracy 918-815-
6586.               12/2021 TFZ

APARTMENTS 
FOR RENT

Your Local Weekly 
Newspaper 

The Best Place 
To Find

• City News
• Sports
• School News  
• Community News

Everything you need 
to know about our 

town!

543-3134
Subscribe Today!
$35

The 
Independent

a for 1 Year
Subscription

The Inola
Independent

P.O. Box 999 • Inola

THEY READ
 for Fun.THEY READ

Fun.THEY READ
What else can enliven and 
entertain like the newspaper? 
It’s what people turn to for a 
heartwarming story or just a 
good laugh.

It’s also your best source for 
the news and information you 
need about your community 
every week.

To subscribe, call: 

543-3134
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every week.
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Independent

  Trash or Treasure. Sell your 
treasures or your unwanted 
in the Inola Independent 
and Catoosa Independent for 
only $5 for 15 words or less. 

ADVERTISE YOUR YARD 
SALE IN THE INOLA 
AND CATOOSA INDE-
PENDENT NEWSPA-
PER. ONLY $5 FOR 15 
WORDS OR LESS

YARD SALE

SNIFF OUT THE 
GREAT DEALS 

IN THE 
CLASSIFIEDS

Sophisticated Seconds Hos-
pice Store, 41st and Yale, 
4016 S. Yale Ave. Tulsa, 
539-664-5177 Open until 
6 p.m. need: Volunteers and 
Donations. Call Rita: 918-
747-2273  

1/6/18 TFZ  NC

HELP NEEDED

NOTICE
One Year Subscription 

to your hometown newspa-
per. Just $35 per year.

Mail a check to the In-
dependent for Black Fox 
Media newspapers dba The 
Independent in Inola and 
Catoosa  P.O. Box 999, In-
ola, Ok. 74036

ZONES: NE
for week of  February 18, 2024
ads may run anywhere in your newspaper. Don’t forget to remind your classified department to download the line ads for 
this week at www.okpress.org (ocan021824) - CHOOSE THE AD SIZE CLOSEST TO YOUR COLUMN WIDTH 

METAL ROOFS 
$4995* INSTALLED
25% OFF SIDING/WINDOWS

LIMITED TIME

CALL NOW! 800-664-4856
TM CONSTRUCTION     

Sr/Military Discounts *Call for details
CALL NOW! 800-664-4856

TM CONSTRUCTION     

Sr/Military Discounts *Call for details

METAL ROOFS 
$4995* INSTALLED

25% OFF SIDING/WINDOWS
LIMITED TIME

Free one time classified 
word ad 15 words or less 
918-543-3134. Call Martha

THANK YOU

Need Your Legals
Published?

PROMPT - ACCURATE
FRIENDLY

The Independent is a weekly 
newspaper that published each 
Wednesday in Rogers County.

Our Services include:
• Accurate & Timely Publication of 
 your legal cases
• Tear sheet & invoice mailed 
 promptly
• FREE filing of paid in full Proof 
 of Publication at the Rogers 
 County  Courthouse weekly
• FREE notarization on the first 
 copy
• Additional copy for your own use.
• Billed for publication - typically no 
 deposit required.

There are 4 ways to send us your legal 
for publication:

1. Email to blackfoxeditor@gmail.com
2. Fax to 918-543-2758
3. Mail to PO Box 999, Inola, OK 74036
4. Drop off at 113 W. Commercial, 
 Inola, Okla

Contact us today for more 
information or any questions that 
you may have about our servcices!
Ask for Martha  @ 918-543-3134

HELP WANTED
So you want to write? Be a 
writer?  We need sports re-
porters. Want to cover your 
hometown athletics - give 
John a call   918-543-3134

Wanted self starting, moti-
vated individual. Socially tal-
ented. Good on one to one 
sales. Call 918-543-3134.  

10-1 TFZ
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er LEGAL ADVICE
is just one of the benefits of being a member of the Oklahoma Press 
Association’s Legal Services Plan. Remove the worry of needing  
professional advice by enrolling today. For more information contact:

OKLAHOMA PRESS ASSOCIATION’S 
LEGAL SERVICES PLAN 

1-888-815-2672 or 405-499-0020

OPA Computer Consultant Wilma 
Newby’s column is brought to you by 
the Oklahoma Advertising Network 
(OAN). For more information on the 
OAN program, contact Oklahoma 
Press Service at (405) 499-0020.

If your newspaper’s size 
is changing, it’s fairly easy to 
set up a new template without 
loosing all the settings from 
the old template.

You need to know the 
new measurements for your 
template, both the overall size 
with margins and the actual 
print area.

To set up a new template in 
InDesign, go to File > Doc-
ument setup. Enter the new 
width and height area (the 

width and height of one page 
plus margins). Set Number 
of Pages and Facing Pages 
to your specifications for the 
template then click OK. 

Now we will add the new 
settings for the margins. In the 
menu go to Layout > Margins 
and columns. In this box enter 
the margins the printer gave 
you and click OK. 

There is a place in this 

box where you can have the 
program automatically adjust 
the content of the paper to 
the new size layout. I don’t 
advise using this. It produces 
many unexpected changes that 
you may not appreciate. Even 
worse, those changes could go 
unnoticed until after the paper 
hits the press. It helps to have 
preview checked so the results 
can be seen without leaving 
this box. 

This next scenario looks at 
how to incorporate new styles 
into a template. This could be 
replacing old styles, or using 
the old style sheets in a new 
layout. Both can be done in 
the Paragraph Styles palette. 

Open Paragraph Styles; if 
it’s not showing up on the left 
side of your screen, look in the 
menus for Type > Paragraph 
Styles.

There is a flyout menu at 
the upper right of the palette 
that brings up a menu list of 
options. Go to Load Paragraph 
Styles... Another box comes up 
asking for the document with 
the new styles; choose it. 

If you’re creating a brand 
new template, just import the 
styles from an older template’s 
InDesign page file. Click 
Open. In the next box choose 

override old styles or just 
bring in all the new ones. 

If you make a mistake, you 
can always select Undo. Save 
when you’re happy with the 
results.

Now let’s organize the 
old styles. In the Paragraph 
Styles palette from the same 
flyout menu go to New Style 
Group... Give the new folder a 
name, for example “Old Styles 
2024.” Then hold down shift 
and select the old styles to be 
moved. Drag all the old styles 
into the folder Old Styles 2024. 

Problems may come from 
the Master pages. When the 
document setup is changed, 
the size of the Master pages is 
also changed. Changes to the 
actual size of the headers must 
be done on the Master pages. 

The same is true for folios 
that are auto-numbered on the 
Master pages. To tell if your 
pages are auto-numbered look 
in the Pages palette. Double 
click the A-Master and see if 
the page numbers are in a for-
mat where the actual number 
is an (A) character instead of 
a number. If so, the pages are 
auto-numbered. 

If you want to set up  
auto-numbering, create the (A) 
character by going to a Master 
page. Then in the folio where 
the page number goes leave 
the flashing (I) beam from the 
text tool in the line and go 
to Insert Special Character > 
Marker > Current Page Num-
ber and the (A) will appear. 
When you click on a regular 

page in the document, you 
will see a number where the 
(A) was on the master. Some 
pages, like page 1, don’t need 
a page number. To remove 
it from a certain page go to 
the flyout menu on the Pages 
palette and then to Override All 
Master Page Items. Now items 
from the master page can be 
changed, moved or deleted. 

If you need to resize items 
on the page, group them 
before resizing. Holding down 
Shift will keep the objects in 
perspective when resizing. The 
Command/Control keys will 
resize without keeping objects 
in perspective. 

When rebuilding templates, 
it helps to start with mostly 
empty pages. Remove all old 
material such as pictures and 
copy from the pages. If there’s 
time, consider replacing all the 
ads. You can also start from a 
blank template already in use.

When you’re done deleting 
old copy, a new template can 
be created. Go to File > Save 
As... and save the file as an 
InDesign Template File. When 
opened normally, template 
files will create a new docu-
ment without a title. 

A template file can be 
changed from the File > Open 
menu by clicking the Open 
Original item button. Then, if 
needed, the template can be 
changed and saved. This is 
very useful if mistakes were 
made in the overall redesign.

Creating templates, as well 
as paragraph and character 
styles, will not only save time 
but will give your publication 
a uniform look. 

Spending a little time now 
to set up templates and styles 
will save time later. 

Computer Notes
from the road

by Wilma Newby
wnewby@okpress.com

How to create new templates in InDesign
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HERE ARE SOME  
SAMPLE QUESTIONS

Routine as well as others, 
these questions are appropriate 
for individuals interviewing to 
be hired by the electorate.
•	 What prompted you to seek 

office? Was it a personal initia-
tive, or were you encouraged? 
By whom?

•	 What are the most important 
issues, and how do you plan to 
address them?

•	 Who do you identify as your 
base of support — specific 
demographics, organizations, 
special interests?

•	 Who are the people most 
opposed to your candidacy, 
and how do you allay their 
concerns?

•	 What is the chief strength and 
weakness of your opponent?

•	 What are your strengths and 
weaknesses, and how will you 
compensate for your weak-
nesses?

•	 What do you bring to the table 
that your opponent doesn’t?

•	 How can you, as one vote, 
make a difference on a poli-
cy-making board?

•	 How is your experience — or 
lack of experience — in the 
public and private sectors a 
plus or minus for the job?

•	 Do you support term limits?
•	 Do you agree with the philoso-

phy that elected officials should 
enact broad policy and staff 
should handle daily adminis-

tration? How do you approach 
this division of responsibilities?

•	 You are elected to represent 
your constituency, yet at some 
point, the collective wishes and 
beliefs likely will contradict your 
personal beliefs. How will you 
arrive at your vote?

•	 What specific practices will you 
use to connect with constitu-
ents?

•	 Does your employment restrict 
your ability to serve?

•	 What one issue is not being 
talked about in this race that 
should be getting aired?

•	 How will you address the 
partisanship that seems to 
have filtered into all levels of 
government?

•	 Political observers routinely 
rate the U.S. president’s first 
100 days in office. What can 
we expect from your first 100 
days?

•	 What is the government’s role 
in providing specific services?

•	 Can government be more effi-
cient by partnering in the deliv-
ery of services and programs? 
Identify some possibilities.

•	 Do you advocate public-private 
partnerships? Identify some  
possibilities.

•	 Your opponent is most critical 
of your stance on this issue. 
How do you respond?

•	 Think of your particular 
community or constituency 20 
years from now. What three 
things must be addressed now 
to make it better for our kids?

•	 How will changing demograph-
ics affect public policy?

•	 Address the balance of public 
policy necessary to satisfy 
both rural and urban constitu-
encies.

•	 How will you ensure gov-
ernment is run in an open 
fashion?

•	 Are there any state or national 
elected leaders, past or pres-
ent, who you admire? Why?

•	 Under what circumstances 
would you change your stance 
on a specific issue?

•	 On whom will you rely for 
advice?

•	 What will be the role of the 
people who contributed to your 
campaign?

•	 What principles will guide your 
decisions? 

•	 At the end of your term, what 
do you hope people will say 
about you?

•	 If interviewing a candidate for a 
profile: Who else do I need to 
interview?

•	 What one question are you 
glad we didn’t ask? Are there 
any skeletons in your closet?

•	 What didn’t I ask that you were 

expecting or hoping I would 
ask?

•	 Do you have anything to add?

Always ask the standard 
questions as responses might 
be unexpected and enlighten-
ing: Why are you running?

Consider this response from 
a candidate seeking a spot on 
the county board. He leaned 
across the desk and stared at 
the editor, opening his mouth 
to reveal his many missing 
teeth. He then answered, 
“Dental insurance.”

You never know a candi-
date’s underlying reasons for 
seeking office.
JIM PUMARLO is former editor of 
the Red Wing  (Minnesota) Repub-
lican Eagle. He writes, speaks and 
provides training on community news-
room success strategies.  He can be 
reached at www.pumarlo.com and 
welcomes comments and questions 
at jim@pumarlo.com.

EDITOR’S NOTE: This article 
appeared in the March 2024 edition 
of Publishers’ Auxiliary, the National 
Newspaper Association’s publication, 
and was reprinted with permission.

Sample Interview Questions
Continued from Page 1
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OKLAHOMA NATURAL GAS CONTEST WINNERS

Enter and Win a  
$100 Check 

from Oklahoma 
Natural Gas!

The January Oklahoma Natural 
Gas Column and Editorial Contest 

was judged by a member of the 
Oklahoma Journalism  

Hall of Fame.

1.	 Each month, submit your entry 
online at okpress.com/ong-
contest. Attachments should 
be in PDF format.

2.	 Entries may also be emailed 
(full-page tearsheet) to 
amartin@okpress.com. Include 
the author’s name, name of 
publication, date of publication 
and category entered (column 
or editorial).

3.	 All entries for the previous 
month must be at the OPA 
office by the 15th of the 
current month. 

4.	 Only ONE editorial and/or 
ONE column per writer per 
month will be accepted.

5.	 Winners will receive a 
Certificate of Achievement, a 
$100 check and the column 
or editorial may be published 
in The Oklahoma Publisher. 
Annual Sweepstakes winners 
will receive a plaque, a $200 
check and may have the 
column or editorial published 
in The Publisher. 

Contest open to staff at  
OPA Legal Newspaper and 

General News Media members.

Although Oklahoma Natural Gas 
Company selects representative 
contest winners’ work for use 
in this monthly ad, the views 
expressed in winning columns and 
editorials are those of the writers 
and don’t necessarily reflect the 
Company’s opinions.

JANUARY EDITORIAL WINNER (Excerpts from editorial. Read entire editorial at okpress.com/ong-contest) 
JEFF FUNK, Enid News & Eagle  
Important Decision: Special session not the time,  
place for tax cut consideration

CONGRATULATIONS TO THE JANUARY WINNERS

Editorial: JEFF FUNK, Enid News & Eagle
Column: CONNIE BURCHAM, Watonga Republican

JANUARY COLUMN WINNER  (Excerpts from column. Read entire column at okpress.com/ong-contest) 
CONNIE BURCHAM, Watonga Republican
Headline: A Bubble Off Plumb

Gov. Kevin Stitt is calling the Oklahoma Legislature back 
into special session Jan. 29  to consider a single topic: 
cutting the state income tax rate by 0.25%. It’s a plan that 
scores political points but lacks practical common sense.
Certainly the idea of paying less income tax is appealing 
to Oklahoma voters. But, the special session at this point 
appears doomed to failure, with Senate leadership poised 
to adjourn the special legislative session just minutes after 
it begins.
Timing for such a special legislative session is awkward, 
coming just a week before the Legislature begins its 
regular spring session. Cutting the Oklahoma income tax, 
a huge source of money state government uses to pay for 
important services, is not something that should be done 
on short notice in a special session. It should be contem-
plated only as part of full state budget discussions and 
negotiations.
The Oklahoma Constitution requires the governor and 
Legislature to balance the budget. So, when Stitt is pushing 
to cut the state income tax, expense cuts or an alterna-

tive revenue source should be identified. That’s not the 
situation here.
Next month, Stitt will present his State of the State speech 
and will propose his budget for the coming fiscal year. 
That’s the proper time and place for such a tax cut pro-
posal. By that time, state leaders also will have the latest 
update on the state’s economy and what income state 
government is expected to receive for 2024-25 operations. 
Other proposals, such as eliminating the state’s sales tax 
on groceries, can be considered as well.
Many state legislators are understandably reluctant to 
eliminate a tax or cut a tax rate. Such cuts are effectively 
permanent, because a large supermajority of both houses 
is required for the Legislature to reverse course and 
increase taxes in case of a future revenue shortfall. That’s 
a really high hurdle for any decision and especially a tax 
decision. With the state receiving a large chunk of revenue 
from a tax on oil and gas production, and that production 
tax depending on an often volatile energy market, the 
state’s revenue is far from guaranteed.

My mother would have been 100 years old today. I find it 
hard to believe she has been gone 15 years, and I catch 
myself every day thinking I should call her and tell her 
about something. 
I think about the things she saw change in her lifetime. 
There were politicians she disliked, and nations she never 
forgave. She’d lived through the second World War and 
those nations killed people she knew and loved. 
She was pretty tough on us, too. I grew up as part of a tribe 
of young’uns that she raised solo after my dad died far too 
young. We’d better stay on the straight and narrow or else. 
None of us ever found out what ‘or else’ meant. We were 
too scared. 
I don’t know how, but we grew up never knowing we were 
poor. I mean dirt had more money. I remember going for 
groceries and driving back as far as we could before we 
ran out of gasoline. All three of us girls went along so we 
could carry bags home. Overnight the older brothers found 
or appropriated gas and the car was home by morning. 
As Christmas approached each year, we picked pecans 
and gathered old newspapers to sell for holiday money. We 
learned the value of hard work and how to wait for what we 
wanted. We learned how to separate wants from needs.

Luckily, I had an older sister whose clothes could be cut 
down to fit me, and a grandmother who lived with us to 
do the handiwork. Looking at it now, I think Grandma 
was probably there not just to help with housework and 
childcare, but also with her own meager Social Security 
and tiny pension.
I learned not to put emphasis on clothes, looks and other 
things girls are prone to obsess about. If any of us were 
leaning toward vanity, the air got let out of us quick with a 
sharp, “What makes you think anyone is looking at you?” 
But the same lady found a way to purchase a deep green 
velvet dress for my first FFA banquet. That was so long 
ago no one knew what a girl FFA member should wear for 
the annual ‘Father and Son Banquet.’ That dress was so 
precious that I saved it and made Christmas dresses out of 
the fabric for my own daughters. 
My dearest hope is that I have passed far more along to 
them than deep green velvet. I pray they have the tenacity, 
perseverance and sheer guts it took to be a runner on Wall 
Street at 18, to be part of the crowd on the street in New 
York on VE Day and to raise a herd of children – her own 
as well as several that needed a safe place to be – as a 
single parent. I hope they see that... 


